MODULE 1 GOALS/EXPECTATIONS:

® HAVE A CLEAR UNDERSTANDING
OF THE DIFFERENCE BETWEEN THE
LEGACY AND ENHANCED WORKSPACES
AND WHEN TO USE THEM

® RECOGNIZE NEW FILE TYPES AND
HAVE A GENERAL UNDERSTANDING
OF WHY THERE ARE SO MANY AND
WHAT EACH RESPECTIVE FILE
SHOULD CONTAIN

® UNDERSTAND THE FUNCTION OF THE GPK
IN THE NEW WORKFLOW

® HAVE A GENERAL UNDERSTANDING
OF WHAT FEATURES AND FEATURE
DEFINITIONS ARE

® KNOW HOW TO CREATE, EDIT,
ANALYZE AND MODIFY A TERRAIN

Revision 11/6/2017



1. Start-Up

A Workspace is a custom MicroStation environment or configuration. Activating the MDT Pre-
Construction Startup Menu will allow the user to select either the Legacy (SS4 GEOPAK
Criteria) or Enhanced (SS4 GEOPAK — OpenRoads Technology*) workspace.

Mapping the W: drive to a CADD standards server is no longer required. Each of the 12 servers
above has copies of the 4 CADD directories. The selections made in the Preconstruction
Startup Menu control what server and directory MicroStation will look at for reference and
configuration files.

Note: It is no longer acceptable to open MicroStation files by double-clicking on the file name in
Windows Explorer. If a W: drive is mapped, this process is not even possible as it causes a
DOS error.

- IR === o)
Preconstruction Startup (Version 1.0.5) . l—lm
Select Server Select Workgroup Select Workspace M

* Helena " Bridge * Legacy
" Billings " Emvirenmental " Enhanced pratEn
" Bozeman " Geotech
. Select Environment
" Butte " Hydraulics
~
" Glendive " Land Survey
o~
" Great Falls " MsU |
{* Production Run Kill Task
™~ Missoula " Photogrammetry l
" Hawre " Right Of \way Run Delete GPKRSC
£ Kalispell ¥ Road *Only use the Start Geopak or Start DpenRoads option
~ ) ~ if you need touse the design tools as starting GEOPAK
Lewistown Satfety Management or OpenRoads will executea license and can affect
. . ) MDT's overall product cost.
" Miles City " Survey English

(™ \Wolf Point ™ Survey Metric Start Docuplot

" Traffic Electrical I
(" Traffic Geometrics

(" Traffic Safety

" Traffic Signing |
—— |
" Visualization View Help | Exit | ‘
12 Servers
18 Workgroups [ CaddStandards
2 Workspaces —T
7 Cadd5tdOR
*For purposes of this training, please [7. CaddTest
consider ‘OpenRoads’ to be synonymous 3 [2) CaddTestOR
with ‘GEOPAK SS4 with OpenRoads - 1 e

Technology’ and not ‘OpenRoads Designer
CONNECT Edition’.
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Workspace Decision Flowchart
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e Use the Legacy workspace for projects currently being designed using GEOPAK

Criteria.
ersion 1.0. [ o= e S
- Select Workgroup—— Start Microstation | I
 Bridge I
" Environmental Hﬂln
" Geotech Start OpenRoads”
) Select Environment
" Hydraulics
" Development
" Land Survey

0 Test

 MSU

% Production Run Kill Task |
” Photogrammetry
fall = a3y Run Delete GPK RSC |

* Road * Only use the Start Geopak or Start OpenRoads oplion
if youneed touse the design tools as stariing GEOPAK
ment or OpenRoads will executea license and can affect
MDT's overall product cost.

" Survey English

" Survey Metric Start Docuplot |

" Traffic Electrical

" Traffic Geometrics

" Traffic Safety

" Traffic Signing

" Utilities M

" Visualization Wiew Help | Exit |

4

User: [MDT -
. Set

Project: ROAD =) automatically

Interface: |VBISS2 -

File Edit FEement Settings Tools Liiities Workspace Applications Window MDT  Subsurface Lty Road Tools Help

B-0-©8-8-E-2-2-R-A-0RuiIR

Tasks o J;l X B Viewd, Default
[ﬁTasks ']::[ﬂv@'—;}v|é QBZIB:i{)@|E.IEzI|u‘3"§,E
1 g ék_]'ﬂ?,é ,5.53—;»5

If Start Microstation is
chosen instead of Start
GEOPAK, these menus
will not be available.

.

By
!:‘?f' Civil Tools i‘]‘
|'~‘t2 Subsurface Utilities ‘ﬁT

¢ Drawing BRERA

O
A
&
©
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e Use the Enhanced workspace for new projects to be designed using either GEOPAK
Criteria or GEOPAK - OpenRoads Technology.

rsion 1.0.5) ._
~Select Workgroup———| [~ Select Workspace Start Microstation |
" Bridge " Legacy
" Environmental " Enhanced |
" Geotech [
) ~Select Envionment — |
" Hydraulics
" Development
" Land Survey
" Test
 MSL
{2 Brotuchion Run Kill Task |
" Photogrammetry

*Only use the Start Geopak or Start OpenRoads option
ol if you need touse the design tools as starting GEOPAK
ety Management or OpenRoads will execute a license and can affect

MDT's overall product cost.

" Right Of \Way Run Delete GPK RSC |
Et’" Road !|

" Survey English

' Survey Metric Start Docuplot |

¢ Traffic Electrical
" Traffic Geometrics

™ Traffic Safety
" Traffic Signing
€ Utlities User Preferences |
" Visualization Vel | Exit |

User |[MDT_OPENROADS =

Set
automatically

Project: | MDT_Road -

Interface: | MDT_S54 -

Project Explorer - 0 X
% Links | M3 Fie

=2 Civil Data
Bl Civil Madel

-

L. Civil Mode! | *¥p Givil Standards

If Start Microstation is chosen instead
of Start OpenRoads, these tabs will not
be available
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e GEOPAK Criteria tools are available in both Legacy (SS4 GEOPAK Criteria) and
Enhanced (SS4 GEOAPK — OpenRoads Technology) workspaces.

e Users will now have 2 separate UPF (User Preference Files); one for the Enhanced
workspace and one for the Legacy workspace. Individual user workspace preferences
will have to be set for each workspace separately.

| . » Computer » Local Disk (C:) » MDOH »

dit View Tools Help

ize v Include in library «

Bvorites
Desktop
Downloads

My Documents

Recent Places

omputer
Local Disk (C:)
. BentleyDownloads
J dgn

J Intel

, ISB

. MDOH

. MDTAPPS

. MDTDATA
. old_DGN

| Oracle

J pdfdas

| Perflogs

Share with Burn MNew folder

-~

Mame

J RESOURCES
/% MDT.DGN
/% MDT_EnhancedWs.dgn
J% MDT_LegacyWs.dgn
|| MDT_Geopak.mas
|| MDT_Openroads.mas

m

| mdt-V8i.mas

(% MDT_Road.PCF

[J# MDT _SUE.PCF

[ MDT Visualization.PCF
(% MDT_OPENROADS.UCF
[ MDT_SUE.UCF

% Patl 554.upf

VEE u1374554.upf
¥ u1374V8i.upf

¢ New software features have necessitated new file types:

Map Files
[ (2D) RODMAF File
[ (30) RDCMA File

[ RDETR Existing Terrain Model File
| RDEFF Existing Features File

[~ RDALM alignment File

[~ RDSUP Super Elevation File

[~ RDCRR. Corridor File

[ RDPTR Design Terrain Model File

[ RDUMA Utility Mapping File

Series

—
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2. Differences between OpenRoads Technoloqgy and GEOPAK-Criteria

¢ OpenRoads Technology utilizes models and views
¢ Unlike GEOPAK Ciriteria, all GEOPAK - OpenRoads Technology data is stored within
the DGN
o The GPK s only necessary for:
= Creating plan/profile sheets
» Visualizing and labeling the alignment and profile for plans production
= Labeling cross sections
= Creating cross section layout sheets
= Drawing ancillary features, etc.
e All topographic survey processed using GEOPAK - OpenRoads Technology is stored in
a 3D MicroStation design file. No GPK needed.
e Graphics generated using GEOPAK - OpenRoads Technology tools utilize Annotation
Scale functionality

Note: With the current implementation of the software, some of the graphics will still need be
annotated using the GEOPAK Criteria Design and Computation Manager (D&C). As with
previous releases of GEOPAK MicroStation, these graphics do not honor the Annotation Scale
setting and still rely on Plot Scale.
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Draw Plan & Profile

tem: | HA_DSMNCL HA DESI

Flement Type: [Chains ~ | § Label Scale: | 100
Key4in Paints: = !
Select Chain to Draw
CNTY_223
DETOUR Line Direction Labels
FFA_1
FFA 2 [7] Line Length Labels
M_RR_BE [7] Line Labels Onby

e OpenRoads Technology tools are found on the MicroStation Task Bar > Civil Tools tab
instead of Applications > GEOPAK pull-down menu.

8875000RDCRRO01.DGN [3D - V8 DG
File Edit Eement Settings Tools Lhiities Workspace Applications Window MOT APPS  Subsurface Uity Road Tool
=1 - = = = S 52«3t ~ 4H - (D an &
DN-B-8-B-@-2-R-F-ORW R
Tasks
@ = Y I XY u View1, Defautt
S — | Tasks halll I A @ o Ol
Jg; [ % Civil Tools =
Civil Tools
=3, E A 4.% @ .9 [A oo gy b 9 Subsurface Utiliies
(-é 1 2""»ﬂ'+>1 »ﬂ?bﬂi?r’;‘b? v Sle Ofesg R, -%J Drawing
" " . it
- Analysis & Reporting == = = ','1 D@mng Composﬂlon
o - & Solids Modeling
i: | ol Z N VR ff }"j =4 & & Surface Modeling
ﬁ\, = Ez G:,‘?‘ Mesh Modeling
= w Y v S y - f Temain Model
S—&' ———— 'i;'i % % - W Feature Modeling
@, ﬂ.ﬂ. General Geometry - - W8 Visualization
= [l Animation
Tp £ Horizontal Geometry L4
L]
'.:w.‘ BH vertical Geometry w
:;f{ & Terrain Model v
e
1}_\ fﬂ Corridor Modeling W [
»
Eﬂﬁp 48 Model Interoperability v
z
T
’J;,\J,-b = Civil Cells v
‘?i’b:". 2 3D Geometry v
Fer - -
$ & | A Survey and
ﬂfg}:’?: m OpenRoads Help -
rhams = =
&, | Drawing v
48l Wisualization -

e Feature Definitions will replace the Legacy D&C Manager database (.ddb) for most
OpenRoads Technology functions. The .ddb is still used for GEOPAK Criteria cross
section and visualization of alignments and profiles.

e OpenRoads Technology tools fully support MicroStation’s Undo functionality.
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3. Modeling vs. Plan Production

For most plans production functions, the GEOPAK tools are still used. See the MDT GEOPAK
training guides for information on the GEOPAK software functions.

Many design functions can be completed with either the GEOPAK tools or the OpenRoads
Technology tools. Geometry import and export functions within the OpenRoads Technology
toolset allow users to move between OpenRoads Technology and the GEOPAK GPK file. The
diagrams below summarize a few of the major workflow processes and relationships between
the GEOPAK tools and the OpenRoads Technology.

Surve

Survey Mapping
and Terrain

/

Terrain models generated using OpenRoads Technology can be exported as Legacy GEOPAK
TIN files, just as GEOPAK TIN files can be imported as terrain models using OpenRoads
Technology tools.

Survey points and linear features created using OpenRoads Technology are contained in the
DGN file and are not stored in a GEOPAK GPK file; however, they can be selectively exported
to a GPK file as needed.

Geometry

OpenRoads <

Alignments and profiles created using OpenRoads Technology civil geometry tools are stored in
the DGN file. The geometric data can be exported to a GEOPAK GPK file as necessary.

Horizontal and

Vertical Geometry

GEOPAK

v

Similarly, GEOPAK (COGO) alignments and profiles stored in the GPK file can be imported as
civil geometry.

Many GEOPAK COGO functions are not supported directly by OpenRoads Technology tools. At

this time, Open Roads Technology civil geometry is exported to the GPK file for plans
production as a part of the workflow process.
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Labeling and Visualization

Plan & Profile
Labeling and

Visualization
GEOPAK

Horizontal and vertical alignments created using OpenRoads Technology civil geometry are
stored graphically in the design file, whereas GEOPAK COGO is stored in the GPK file.

Vertical alignments can only be viewed in a dynamic profile view, thus, not allowing it to be used
for plans production. Therefore, all alignments and profiles for plans production are visualized
using the GEOPAK D&C Manager.

Plan and Profile Sheets

Plan and
Profile Sheets

GEOPAK

For plan and profile sheet generation, both the horizontal and vertical geometry must be
exported to a GPK file and plotted using the GEOPAK D&C Manager.

Once horizontal and vertical alignments have been plotted, plan and profile sheets are created
in the traditional manner using the GEOPAK process.

Superelevation

Superelevation

GEOPAK
OpenRoads

Superelevations are computed using the GEOPAK Automated Superelevation tool and are
stored in the DGN file using sections containing shapes for each lane. If needed, a GEOPAK
Shape Input File (.INP) can be imported for use with OpenRoads Technology; however,
superelevations created with OpenRoads Technology cannot be exported for use with the
GEOPAK tools.

10
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Cross Sections

Cross Sections

OpenRoads cross sections are a byproduct of the 3D model and are generated using

OpenRoads Technology tools. All OpenRoads Technology commands are utilized with the
intent to generate a 3D model and cross sections. Cross sections generated by OpenRoads
Technology are placed in the DGN model with a GEOPAK Cross-Section Cell for use with

GEOPAK Crite

A combination

ria cross section functions.

of GEOPAK and OpenRoads Technology tools can be utilized to cut, annotate

and run earthwork on cross sections.

4. Desiqgn File Type Descriptions

Map Files

[ (2D) RDMAP File [ RDETR Existing Terrain Model File
[ (3D)RDCMA File [~ pnerr Eyisting Features File Series
[~ RDALM alignment File

[~ RDSUP Super Elevation File
[~ RDCRR. Corridor File
[ RDPTR Design Terrain Model File

[ RDUMA Utility Mapping File

Revision 11/6/2017

RDMAP — 2D Strip Map File
= Al COGO visualization of alignments and profiles
= Line work for edge of pavement, sidewalk, curb, etc.
RDCMA — 3D Contour Map File
= For Criteria projects only
RDETR — Existing Terrain Model File
= Existing ground terrain model
= Created from survey-provided 3D elements, TIN, or DTM file(s)
RDEFF — Existing Features File
» Road Design copy of Survey files
= Elements are featurized
RDALN — Alignment File
= Contains all civil alignments and profiles
= Contains corridor external reference elements (for point controls)

11




o RDSUP — Superelevation File
» Contains superelevation sections and lanes
o RDCRR - Corridor File
= Contains 3-dimensional roadway model
= Corridor length: based on complexity and template drops
= Suggested length 1-3 miles
= Create separate CRR files for crossroads and approaches
= No more than 25 approach corridors per file
o RDPTR - Proposed Terrain File
= Created from 3-dimensional break lines created by the corridor
template(s)
o RDUMA - Utilities Map File
» 3-dimensional visualization of utilities with known depths and clearances
= Utilities modeled in the 3-D environment
* Proposed and existing culverts

Note: Standard DMS file-naming conventions apply.

5. File Referencing Relationships for Modeling with OpenRoads

Technology
o RDETR
= RDEFF —only if the existing terrain model is created from 3D elements
o RDALN
= RDETR
» RDEFF
o RDSUP
= RDALN
o RDCRR
= RDETR
» RDEFF
= RDALN
= RDSUP
o RDPTR

= RDALN (3D)
= RDCRR (3D)

o RDXSF
= RDETR
= RDALN
= RDCRR
= RDEFF
= RDUMA

e Plans production sheet file types retain the same naming format (PLP, DET, etc.)

12
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e Files created in the Enhanced workspace will have a resolution of 10,000 units vs. the
Legacy workspace with a resolution of 1,000 units.

Note: Seed files should not be mixed, because this will cause referencing issues due to the
different file origins. Plans production sheet seed files CANNOT be mixed. All sheets across all
disciplines (including any external consultant files) must be the same units for Contract Plans to
plot. Also, Contract Plans Books (.cpb) can only be plotted from the workspace used to create
the sheet files.

i.e. 10,000-unit plan sets can only be plotted from the Enhanced workspace.

6. User Interface Setup

As part of MDT Best Practice, it is suggested that the following menus, toolbars, and
dialogs are opened and docked as part of the user interface. These tools are available in
both Legacy and Enhanced workspaces.

= Task Bar
= Tools > Tasks
Tasks -« 0 X
J‘TE!sks - |
| < Civil Tools |‘
E T O @B LY [ oo
1 2---">ﬂj‘>i—|}>rﬂi 1‘»@»% Bl
@ %
N shs 0
Tools | w Primary < Analysis & Reporting '3
C @ Standard it General Geometry Em = mm A
_| Main Classic 3 - My iy & :
x| a1t g @ 8 .0
— Annotati 3 L
MEI [0 :’-\LDI:HI IDCn rdinat 2 " 27 Z' /
ary Coordinates — > 7
B-Spline Curves 4 E el 3 @ yﬁ
23 Databasze 4 R s J‘E _'—3;]
DD Design 3 =
0D Cell Tools » «<_ Horizontal Geometry L
i Dimension Tools 3 BB vertical Geometry v
Wain & Terrain Model v
Product Add-ins 2 : :
v |Tasks |I fil corrider Madeling v
D R 48 ModelInteroperability -
rop
E-Lirks » = civil cells v
E Feature Modeling 4 2 3D Geometry A4
Fillets » 5 .
/M Survey il
lzometric »
Match b ﬂ CpenRoads Help v
Muttidines 4 “J Drawing A4
= Element Information
13
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iew 1 Default

= Civil Accudraw Toolbar
=  Tools > Civil Accudraw > Activate Toolbar

% o [0 ® T o X X

Note: The user should never have Microstation Accudraw and Civil Accudraw active at the
same time.

= Civil Message Center

=" Analysis & Reporting
ﬂ_!l_ General Geometry
a Ia ¥, g @ @
W L7y

= by q i Y"'}

2

Show All | & 50 Micro5tation @UErrors 14 0 Warnings 00 Messages

Element Message

4 (LI F
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Drawing Scale

The Project Explorer dialog is used extensively with OpenRoads Technology. To

change the Project Explorer settings, go to Settings > Project Explorer

m Project Explorer Settings

S|

Browsers ~
False [=]
Civil Standards True
Civil Model True
Ltility Model False
File False
Links False
Display s
Dimension Styles True
Text Styles True
Tag Sets True
Settings | Toolz  Lhtilties Saved Views True
|— _ Shared Cells True
v Tool Settings vl True
ﬂ Aol Models True
Enlur Books Levels in a Model True
= MNamed Groups True
Color Table... Attachments True
Database Rasters True
Design File Point Clouds True
&) Display Styles Elements True
SET S Dialog Properties e
(i) Element Irformation
Lovels i (i
5 Locks A mum e Coun
Message Center DGN Indexing Properties R
Prit Styles Indexing Service Stopped |
& I Project Explorer
I_:E] Bendering L DK J[ Cancel ]
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Recommended Settings:

Browsers
Set the Civil Standards and Civil Model options to True.

Dialog Properties
Set the Browse Layout option to Tab.

= Civil Model Browser
The Civil Model tree contains all of the civil data contained in or
referenced into the DGN. The first level will contain as many branches as
there are referenced files.

£ Civil Model “® Civil Standardsl
= Civil Data
=+ 8074000RDCRRO01.DGN, Defautt ‘._______

G-, Linear Elements Current DGN

----- - Poirt Elements
--45,';3 30 Linear Elements
% Temain Models
Jj_' fi Comidors

- Superelevation

i Civil Cells
- Civil Objects Referenced DGN

-+ Referenced Models /
B+ B074000RDETRO01.DGM, Default

----- " Linear Elements

----- ¢ Point Bements
= 30 Linear Elements
Ej—-% Temain Models
-l Comidars

----- 7 Superslevation
ok Civil Cells

----- # Civil Objects

----- £ Referenced Models

= Civil Standards Browser
The OpenRoads Technology uses MicroStation DGN Libraries to define
various standards used by both OpenRoads Civil and Survey tools.
These DGN libraries are defined by the MDT workspace.

When a new MicroStation design file is created, these standards are
referenced by the configuration and can be reviewed from the Civil
Standards tab of the Project Explorer dialog.

16
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Project Explorer

“W Cwil Standards | [ Survey

=-“# Civil Standards
EIEE B074D00RDCRRO01.DGN, Default
Civil Cells
Design Standards
S
Project Settings
Temain Filters
|kility Fitters
Libraries
-y Civil Cells
w3 Design Standards
-3 Feature Defintions
-y Project Settings
-3 Temain Filters
~niy Lhility Filters

s

s OO oy PO PO s O e PO e
i el gl

i

-

1]

o

=

i

[

&

=

=

[=]

=3

@

ElEE]

The Civil Standards tree contains two main branches; one for the active
design file, and one for Libraries.

When a new file is created, the standards are initially defined only in the
Libraries branch. These are the default standards, stored on the CADD
server, that are defined for MDT projects.

As a particular standard is accessed, the standard is copied to the active
file.
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Ejec't Explorer v ]
[ %= Links | W8 Fie | < Gwil Model | " Cwi Standards
=-“ Civil Standards
EI@ 8875000RDCRRO01.DGN, Default
o8 Civil Cells
Design Standands
Feature Definitions
Lij |~ Components
EI ,. Grading

[V Grade_Cut
[V Grade_Fil \
{V1& Grade_Rock_Surface Copied feature

Grade_Veg_Grass definition
¥~ Roadway

i-[#]~ Linear

i-[#],~ Temain Display

| Project Settings

Temain Fiters

A8 Uility Filters

Libraries

Civil Cells

Design Standards

Feature Definttions

-w Feature Definition Modsl {1MDT_Feature_Definttions_Survey_In
-y Feature Definition Model (2MDT_Feature_Defintions_ROW _my
- Feature Definition Model (3MDT_Feature_Definitions_Environmé
-y Feature Definition Model (SMDT_Feature_Defintions_Land Surv
- Feature Definition Model (MDT_Feature_Defintions_Road_Impe
E-@ Componerts

G- Drafting Artifacts

G- Drainage

G- Edsting

Elﬂr Grading

- Grade_ClearZone

- Grade_Cut
iiiﬁ g:ﬂ?ﬁﬁ& DGN Library
&g Grade_Fil feature definition

- Grade_Fill Buffer

-y Grade_Rock_Surface
- Grade_Topsoil

-y Grade_Veg_Grass

- Grade_Veg_Seeding 142
- Grade_Veg_Seeding3

.= Rrachazr

i

=+1...[+1

=

[
I:I-'.

m

Changes to the standards library will not be reflected in a DGN unless the
DGN is manually updated to reflect the current standards library.
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7. Desiqgn File Settings

Design file settings are initially defined in the MDT seed files and have been configured to MDT
project standards. They should rarely need to be changed.

- - . o F & =
Settings | Tools Ltilties V] Design e il — -
v Tool Settings Category Export Settings A
. Active Angle
1 AccuDraw Active Scale Export To Natve  Use Feature Setting
Color Boolks Angle Readout ) -
Color Tabl B Coordinate Settings ~
= Civil Formatting Eorat XY
Database Colaor o
. Precizion 0.123
| Design File Element Attributes
@ Display Styles (I_:;igce Ratio Settings (Distance:Offset) A&
Drawing Scale |sometric Format 1:D
(1) Element Information Locks Precision 0.12
Level ’ Snaps
EVES Stream Station Settings ~
(& Locks ] Views = 2
Message Center Working Units e e
; f Format Delimiter  +
Print Styles IMPOrant fora Precision 0.12
& Project Esplorer annotation NP\& Eguation By Index
Radius Settings ~

Degree Of Curve Method Arc
Degree Of Curve Length  100.000
Radius Toggle Char d

Profile Settings -
Elevation Precision 0.12

Slope Format Percentage
Slope Precision 0.12

Ratio Format Run:Rize

Ratio Precision 012

ertical Curve Parameter Kvalue

Coordinate Settings

The Format can be set to X, Y or N, E as desired.
The Precision setting is used to control the display and precision of coordinates
within the various civil and survey dialogs.

Station Settings

Controls the format, delimiter and precision of the station values to be used and
displayed in the various civil dialogs. In addition, there are two options to control how
equations are represented within the station values.
*» By Index - This is the standard GEOPAK presentation (100+00 R 1, 105+00 R 2,
etc.)
= By Name - This is the standard InRoads presentation (A100+00, B105+00, etc.)

Note: In order for auto-annotation to work, Station Settings > Equation must be set to By Index.
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8. Feature Definitions

Feature Definitions describe the Engineering Properties and define the Symbology for
a feature.

Engineering Properties allow the feature to model the real world ‘thing’ it
represents.

Symbology settings allow the feature to be displayed properly in various
context (ex: 2D Model, Cross Section, 3D Model).

Feature Definitions used for civil elements like terrains are an efficient way to use
multiple Element Templates for one element.

Current alignment Feature Definitions reference the Legacy .ddb file used in the
GEOPAK Design & Computation Manager to allow for the creation of annotation
(stationing, tick marks, and curve data).

A variety of Feature Definitions are configured for common display options and stored in
DGN libraries. When a Feature Definition is used, that Feature Definition and the
associated Element Templates are copied into the active DGN file.

Project Explorer v I

“W@ Civil Standards | ] Survey Aufih

=I-“# Civil Standards
- 2074000RDCRRO0Z_West DGN, [

-l Civil Cells
ii o E _
=-[¥[8 Feature Definttions
Components

Dlesign

Linear
MDT_STandard ddb
- MDT_Survey

+@ Temain Fitters

-l Uility Filters

H-i¥ Libraries

HEIEIEE

¥
¥
+
¥

Feature types can be defined as:

= Linear
=  Point
=  Surface

Linear and Point Feature Definitions are used to control a wide variety of parameters
for each feature. A Feature Definition can be configured to read settings from a
GEOPAK DDB file or a MicroStation Element Template.

Surface Feature Definitions are used to define terrain model display parameters for the
model itself as well as any profiles that are extracted from the terrain model.
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Feature definitions can only be assigned in the file the element resides in, even when
the Override Symbology option is turned on.

Feature Name Existing sl g’ayed out
Feature Definition  Desion_Contours

- CALETIOEU
Reference »
Dverride Symbology K Gy [=]

Feature Definitions can be overridden by changing the display options in the Element
Information dialog. These overrides do not carry over into references. They must be
reset in each file after the Override Symbology option is turned on.
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